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INSTALLATION GUIDE

CAN Hardware and NI-CAN™ Software
for Windows

This installation guide contains instructions to help you install your
NI-CAN system. Complete documentation is in the NI-CAN Hardware and
Software Manual, which is available on your NI-CAN Software for
Windows CD in Adobe Acrobat portable document format (PDF). Refer to
the file NI-CAN Hardware and Software Manual.pdf on the CD or
in the NI-CAN\Documentation folder on your hard drive.

The NI-CAN software on this CD supports Microsoft Windows operating
systems.

This installation guide covers all National Instruments hardware products
for CAN on the PCI, PCMCIA, and PXI buses. It is written for users
already familiar with Windows.

Install the NI-CAN Software Before the Hardware

Before installing the CAN software, users must first log on as
Administrator or as a user with Administrator privileges. The NI-CAN
setup program must have Administrator privileges because the program
modifies the configuration registry of your system.

Complete the following steps to install the NI-CAN software.

1. Insert the NI-CAN Software for Windows CD into your CD-ROM
drive. The installer launches if your CD-ROM drive plays data CDs
automatically.

If the installer does not launch automatically, navigate to the CD using
Windows Explorer and launch the autorun file from your NI-CAN
Software for Windows CD.

2. The Installation Wizard guides you through the necessary steps to
install the NI-CAN software. You can go back and change values
where appropriate by clicking Back. You can exit the setup where
appropriate by clicking Cancel.

National Instruments, NI, ni.com, and LabVIEW are trademarks of National Instruments Corporation. Refer to the Terms of Use section on
ni.com/legal for more information about National Instruments trademarks. Other product and company names mentioned herein are
trademarks or trade names of their respective companies. For patents covering National Instruments products, refer to the appropriate location:
Help»Patents in your software, the patents . txt file on your CD, or ni . com/patents.
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3. If you have LabVIEW Real-Time (RT) installed on your system,
download the NI-CAN driver support for your Real-Time PXI
controller. Launch Measurement & Automation Explorer (MAX) and
follow the online help to download NI-CAN Real-Time components to
your Real-Time PXI controller.

4. Power down your computer when the setup is complete.

Proceed to the Install the CAN Hardware section.

Install the CAN Hardware

This section describes how to install your CAN hardware on the PCI,
PCMCIA, and PXI buses.

Install Your PCI-CAN Card

A Caution Before you remove the card from the package, touch the antistatic plastic package
to a metal part of your system chassis to discharge electrostatic energy, which can damage
components on your CAN card.

Make sure that your computer is powered off and unplugged.

2. Remove the top cover (or other access panels) to give yourself access
to the computer expansion slots.
Find an unused PCI slot in your computer.

4. Remove the corresponding slot cover on the back panel of the
computer.

5. Insert the CAN card into the slot with the CAN connector(s) sticking
out of the opening on the back panel. It might be a tight fit, but do not
force the interface into place.

6. Screw the mounting bracket of the CAN card to the back panel rail of
the computer.

7. You can use a RTSI cable to connect your CAN-card RTSI interface to
other National Instruments RTSI-equipped hardware. Refer to the
RTSI section of Chapter 3, NI-CAN Hardware, of the NI-CAN
Hardware and Software Manual for more information about the RTSI
interface on your CAN card.

Replace the top cover (or the access panel to the expansion slot).

9. Proceed to the Verify Your Installation section.
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Install Your PCMCIA-CAN Card

A Caution Before you remove the card from the package, touch the antistatic plastic package
to a metal part of your system chassis to discharge electrostatic energy, which can damage
components on your CAN card.

4,

Insert the card into a free PC Card (PCMCIA) socket.

Connect your PCMCIA-CAN cable to the card. The NI-CAN software
auto-detects which cable has been attached to the card.

You can use a PCMCIA-CAN synchronization cable to connect your
PCMCIA-CAN card to timing and triggering signals on another
device.

Refer to the PCMCIA-CAN section of Chapter 3, NI-CAN Hardware,
of the NI-CAN Hardware and Software Manual for more information
about the PCMCIA-CAN synchronization interface.

Proceed to the Verify Your Installation section.

Install Your PXI-CAN Card

A Caution Before you remove the card from the package, touch the antistatic plastic package
to a metal part of your system chassis to discharge electrostatic energy, which can damage
components on your CAN card.

Make sure that your PXI or CompactPCI chassis is powered off, and
unplug the computer.

Choose an unused PXI or CompactPCI peripheral slot.
Remove the filler panel for the peripheral slot you have chosen.

Touch a metal part on your chassis to discharge any static electricity
that might be on your clothes or body.

Insert the PXI card into the selected slot. Use the injector/ejector
handle to fully inject the card into place.

Screw the front panel of the PXI card to the front panel-mounting rail
of the PXI or CompactPCI chassis.

Proceed to the Verify Your Installation section.

Verify Your Installation

1.

© National Instruments Corporation

Power on your computer and start Windows.

A New Hardware Found dialog box appears. If a dialog box appears
and does not go away on its own, choose the default option, Install the
Software Automatically (Recommended), and let the operating
system install the driver files.
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If the New Hardware Found dialog box does not appear when you
restart Windows, refer to Appendix A, Troubleshooting and Common
Questions, of the NI-CAN Hardware and Software Manual for more
information.

2. Launch Measurement & Automation Explorer (MAX) and refresh
(press <F5> or choose View»Refresh from the menu). Your CAN
cards should be listed now under Devices and Interfaces. To test all
detected CAN cards, choose Tools»NI-CAN»Test All Local Cards
from the menu.

3. Proceed to the Connect the Cables section.

Connect the Cables

After you have installed the CAN interface, connect your CAN cables to
the interface. Because exact cabling requirements vary for each
application, National Instruments does not provide cables, other than the
PCMCIA-CAN cable. Refer to Chapter 4, Connectors and Cables, of the
NI-CAN Hardware and Software Manual for information about the cabling
requirements of the CAN hardware.

Uninstalling the NI-CAN Software

Before uninstalling the NI-CAN software, remove all CAN interface
hardware from your computer.

Complete the following steps to remove the NI-CAN software.

1. Run the Add/Remove Programs applet from the Control Panel.
2. Select National Instruments Software. Click the Change button.
3. Select NI-CAN in the list of products and click Uninstall.

The uninstall program removes all folders, utilities, device drivers, DLLs,
and registry entries associated with the NI-CAN software. The uninstall
program removes only items that the installation program installed.

If you have added anything to a directory created by the installation
program, the uninstall program cannot delete that directory because it is not
empty after the uninstallation. Remove any remaining components
manually.

After the uninstall program completes, restart your computer.
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Further Documentation

Complete documentation is in the NI-CAN Hardware and Software
Manual, which is available on your NI-CAN Software for Windows CD in
Adobe Acrobat portable document format (PDF). The manual includes a
Troubleshooting and Common Questions section with more detailed
information on installation and configuration of your NI-CAN software
and hardware. Refer to the file NI-CAN Hardware and Software
Manual .pdf on the CD or in the NI-CAN\Documentation folder on
your hard drive.
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INSTALLATIONS-ANLEITUNG

CAN-Hardware und NI-CAN-Software
fur Windows

Diese Anleitung enthélt Anweisungen fiir die Installation Thres
NI-CAN-Systems. Sie finden die vollstindige Dokumentation im NI-CAN
Hardware and Software Manual, das auf Threr NI-CAN Software fiir
Windows-CD im Adobe PDF-Format vorliegt. Sie finden die Datei NI -CAN
Hardware and Software Manual.pdf auf der CD oder im Ordner
NI-CAN\Documentation auf Ihrer Festplatte.

Die NI-CAN-Software auf dieser CD unterstiitzt Microsoft
Windows-Betriebssysteme. Diese Installations-Anleitung bezieht sich auf
alle National Instruments-Hardwareprodukte fiir CAN mit PCI-, PCMCIA-
und PXI-Bussen. Das Dokument wurde fiir Anwender geschrieben, die
bereits mit der Bedienung von Windows vertraut sind.

Installieren der NI-CAN-Software vor der Hardware

Bevor Sie die CAN-Software installieren, miissen Sie sich als
Administrator oder als Anwender mit Administrator-Rechten
anmelden. Sie benotigen bei der Installation der NI-CAN-Software
Administrator-Rechte, weil das Installationsprogramm die
Konfiguration Thres Systems dndert. Fiihren Sie die folgenden Schritte aus,
um die NI-CAN-Software zu installieren:

1. Legen Sie die NI-CAN-Software fiir Windows-CD in IThr
CD-ROM-Laufwerk ein. Wenn Thr CD-ROM-Laufwerk Daten-CDs
automatisch startet, beginnt nun die Installation. Wenn die Installation
nicht automatisch startet, wechseln Sie im Windows Explorer zu IThrer
NI-CAN-Software fiir Windows-CD und starten Sie die Datei
setup.exe.

2. Der Installationsassistent fiihrt Sie durch die notwendigen Schritte, um
die NI-CAN-Software zu installieren. Mit der Schaltflache Zuriick
gehen Sie einen Schritt zuriick, um gegebenenfalls Werte zu dndern.
Sie konnen die Installation mit der Schaltfliche Abbrechen verlassen.

3. IstLabVIEW Real-Time (RT) auf Ihrem PC installiert, miissen Sie die
NI-CAN-Treiberunterstiitzung fiir Ihr Real-Time PXI-Steuergerét
herunterladen. Starten Sie dazu den Measurement & Automation

National Instruments, NI, ni.com und LabVIEW sind Marken der Firma National Instruments Corporation. Nahere Informationen zu den Marken von
National Instruments finden Sie im Abschnitt Terms of Use unter ni . com/legal. Sonstige hierin erwéhnte Produkt- und Firmenbezeichnungen sind
Marken oder Handelsnamen der jeweiligen Unternehmen. Néhere Informationen tiber Patente auf Produkte von National Instruments finden Sie unter
Hilfe»Patente in Ihrer Software, in der Datei patents. txt auf Ihrer CD oder unter ni . com/patents.
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Explorer (MAX) und folgen Sie den Anweisungen der Online-Hilfe,
um NI-CAN Real-Time-Komponenten fiir [hr Real-Time
PXI-Steuergerit herunterzuladen.

4. Schalten Sie Ihren Computer aus, wenn die Installation beendet ist.

Fahren Sie nun mit Installieren der CAN-Hardware fort.

Installieren der CAN-Hardware

In diesem Abschnitt erfahren Sie, wie Sie Thre CAN-Hardware mit PCI-,
PCMCIA - und PXI-Bussen installieren.

Installieren der PCI-CAN-Karte

A Achtung Bevor Sie die Karte aus der Verpackung nehmen, halten Sie die antistatische
Kunststoffverpackung an ein Metallteil Ihres Systemgehiuses, um elektrostatische Energie
zu entladen, die verschiedene Komponenten Threr CAN-Karte zerstoren konnte.

1. Stellen Sie sicher, dass IThr Computer abgeschaltet und vom Stromnetz
getrennt ist.

2. Entfernen Sie die obere Abdeckung (oder andere Zugénge) des
Computers, um auf die Steckplitze zugreifen zu konnen.

Wihlen Sie in Threm Computer eine freie PCI-Schnittstelle.

4. Entfernen Sie die zugehorige Abdeckung auf der Riickseite des
Computers.

5. Stecken Sie die CAN-Karte so in den Steckplatz, dass die
CAN-Anschliisse auf der Riickseite des Computers sichtbar sind.
Stecken Sie die CAN-Karte nicht mit Gewalt in den Steckplatz.

6. Schrauben Sie die Halterung der CAN-Karte an der Schiene an der
Riickseite Thres Computers fest.

7. Sie konnen ein RTSI-Kabel verwenden, um die RTSI-Schnittstelle
Threr CAN-Karte mit anderer Hardware von National Instruments, die
RTSI unterstiitzt, zu verbinden. Weitere Informationen zur
RTSI-Schnittstelle Threr CAN-Karte finden Sie im Abschnitt RTSI des
dritten Kapitels NI-CAN Hardware des NI-CAN Hardware and
Software Manuals.

SchlieBen Sie die obere Abdeckung bzw. den anderen Zugang wieder.

9. Fahren Sie nun mit Verifizieren der Installation fort.

CAN-Hardware und NI-CAN-Software fiir Windows 14 ni.com



Installieren der PCMCIA-CAN-Karte

A Achtung Bevor Sie die Karte aus der Verpackung nehmen, halten Sie die antistatische
Kunststoffverpackung an ein Metallteil Ihres Systemgehiuses, um elektrostatische Energie
zu entladen, die verschiedene Komponenten Threr CAN-Karte zerstoren konnte.

1. Stecken Sie die Karte in einen freien PCMCIA-SIot.

2. SchlieBen Sie Ihr PCMCIA-CAN-Kabel an der Karte an. Die
NI-CAN-Software erkennt automatisch, welches Kabel Sie an der
Karte angeschlossen haben.

3. Sie konnen ein PCMCIA-CAN-Synchronisationskabel verwenden,
um Thre PCMCIA-CAN-Karte an Zeit- und Triggersignale einer
anderen Karte anzuschlieBen. Weitere Informationen zur
PCMCIA-CAN-Synchronisationsschnittstelle finden Sie im Abschnitt
PCMCIA-CAN des dritten Kapitels NI-CAN Hardware des NI-CAN
Hardware and Software Manuals.

4. Fahren Sie nun mit Verifizieren der Installation fort.

Installieren der PXI-CAN-Karte

A Achtung Bevor Sie die Karte aus der Verpackung nehmen, halten Sie die antistatische
Kunststoffverpackung an ein Metallteil Ihres Systemgehiuses, um elektrostatische Energie
zu entladen, die verschiedene Komponenten IThrer CAN-Karte zerstoren konnte.

1. Stellen Sie sicher, dass Ihr PXI- oder CompactPCI-Gehéuse
abgeschaltet ist, und trennen Sie den Computer vom Stromnetz.

2. Wibhlen Sie einen freien PXI- oder CompactPCI-Steckplatz.
Entfernen Sie das Fiillelement des gewihlten Steckplatzes.

4. Beriihren Sie ein Metallteil des Computer-Gehiuses, um
elektrostatische Energie zu entladen, die sich in Ihrer Kleidung oder
Threm Korper befinden konnte.

5. Stecken Sie die PXI-Karte in den gewihlten Steckplatz. Verwenden
Sie den Injector-/Ejectorgriff, um die Karte richtig einzustecken.

6. Schrauben Sie die Frontplatte der PXI-Karte an der Fronthalterung des
PXI- oder des CompactPCI-Gehéuses fest.

7. Fahren Sie nun mit Verifizieren der Installation fort.

Verifizieren der Installation

1. Schalten Sie IThren Computer an und starten Sie Windows. Der Dialog
Neue Hardware gefunden erscheint. Wenn der Dialog erscheint und
nicht von alleine wieder verschwindet, wihlen Sie die
Standard-Option Automatische Installation der Software

© National Instruments Corporation 15 CAN-Hardware und NI-CAN-Software fiir Windows



Verhinden der Kabhel

(Empfohlen), und lassen das Betriebssystem die Treiberdateien
installieren. Falls der Dialog Neue Hardware gefunden nicht
erscheint, nachdem Sie Windows neu gestartet haben, erhalten Sie
weitere Informationen im Anhang Troubleshooting and Common
Questions im NI-CAN-Hardware and Software Manual.

Starten Sie den Measurement & Automation Explorer (MAX) und
aktualisieren Sie die Ansicht, indem Sie die Taste <F5> driicken oder
im Menii Ansicht»Aktualisieren wihlen. Ihre CAN-Karten sollten
jetzt unter Gerdte und Schnittstellen aufgelistet sein. Um alle
gefundenen CAN-Karten zu testen, wihlen Sie im Menii
Werkzeuge»NI-CAN»Alle lokalen Karten testen.

Fahren Sie mit dem Abschnitt Verbinden der Kabel fort.

Nachdem Sie die CAN-Schnittstelle installiert haben, schlieen Sie die
CAN-Kabel an die Schnittstelle an. Da sich die exakten Anforderungen
beziiglich der Kabel von Anwendung zu Anwendung unterscheiden, bietet
National Instruments keine CAN-Bus-Kabel an. Weitere Informationen
iiber die Voraussetzungen zur Verkabelung der CAN-Hardware erhalten
Sie in Kapitel 4, Connectors and Cables, des NI-CAN Hardware and
Software Manuals.

Deinstallieren der NI-CAN-Software

Bevor Sie die NI-CAN-Software deinstallieren, miissen Sie alle
CAN-Schnittstellen-Hardware aus Threm Computer entfernen. Fiihren Sie
die folgenden Schritte aus, um die NI-CAN-Software zu entfernen.

1.
2.

Wihlen Sie in der Systemsteuerung das Symbol Software.

Wihlen Sie National Instruments Software. Klicken Sie auf die
Schaltfliche Andern.

Waiihlen Sie aus der Liste NI-CAN und klicken Sie auf Deinstallieren.
Die Deinstallation entfernt alle Ordner, Utilities, Gerite-Treiber, DLLs
und Eintrige, die sich auf die NI-CAN-Software beziehen. Das
Deinstallationsprogramm entfernt nur die Elemente, die dieses
Programm auch installiert hat. Wenn Sie eine Datei in einem der vom
Installationsprogramm erzeugten Ordner hinfiigt haben, kann das
Deinstallationsprogramm diesen Ordner nicht 16schen, weil der
Ordner nach der Deinstallation nicht leer ist. Entfernen Sie die
verbleibenden Komponenten manuell. Starten Sie IThren Computer
nach dem Ende der Deinstallation neu.
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Weitere Dokumentation

Sie finden die vollstindige Dokumentation im NI-CAN Hardware and
Software Manual, das auf Threr NI-CAN Software fiir Windows-CD im
Adobe PDF-Format vorliegt. Das Handbuch enthélt einen Abschnitt
Troubleshooting and Common Questions mit weiteren Informationen zur
Installation und Konfiguration Ihrer NI-CAN-Software und -Hardware. Sie
finden die Datei NI-CAN Hardware and Software Manual.pdf auf
der CD oder im Ordner NI-CAN\Documentation auf Ihrer Festplatte.
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